DISCLAIMER

The contents of this manual do not necessarily reflect the official views or policies of the Indiana Department of Transportation (INDOT). The details in this manual are intended for reference only, not as specifications or design guidance. In the event that any information presented herein conflicts with the Indiana Design Manual, INDOT Standard Specifications or other INDOT policy, said policy will take precedence.
# TABLE OF CONTENTS

1 INTRODUCTION ............................................................................. 1

2 INSTALLATION GUIDE .................................................................. 2

2.1 BEFORE INSTALLING .................................................................. 2

2.2 INSTALLING iSub ....................................................................... 3

3 OVERVIEW .................................................................................... 6

3.1 APPLICATION MENU ..................................................................... 6

3.1.1 FILE .................................................................................. 6

3.1.2 VIEW ................................................................................. 7

3.1.3 HELP .................................................................................. 7

3.2 TAB .......................................................................................... 8

3.2.1 GENERAL ........................................................................... 8

3.2.2 ANALYSIS INPUT ................................................................. 9

3.2.3 RESULT ............................................................................. 10

3.2.4 ATTACHMENTS .................................................................. 11

4 GETTING STARTED ...................................................................... 12

4.1 LAUNCHING iSub ...................................................................... 12

4.2 DESIGN EXAMPLE ...................................................................... 13

4.2.1 STEP 1 .............................................................................. 13

4.2.2 STEP 2 .............................................................................. 14

4.2.3 STEP 3 .............................................................................. 15

4.2.4 STEP 4 .............................................................................. 16

4.2.5 STEP 5 .............................................................................. 17

4.2.6 STEP 6 .............................................................................. 18

4.2.7 STEP 7 .............................................................................. 19

4.2.8 STEP 8 .............................................................................. 22
1 INTRODUCTION

The evaluation software “INDOT Pavement Subsurface Condition Evaluation (iSub)” was developed as part of the JTRP/SPR-3507: Project Evaluation Methods for Pavement Preservation Treatment to aid the pavement subsurface condition evaluation. The software is entirely based on the “Guidelines of subsurface condition evaluation for pavement preservation.” Thus, iSub provides user-friendly system which helps to follow the hierarchy of evaluation steps. Furthermore, iSub automatically calculates the overall condition of the pavement subsurface as severity rating for each laboratory test result was implemented into the software.
2  INSTALLATION GUIDE

2.1  BEFORE INSTALLING

iSub was developed using ADOBE Flex technology and requires ADOBE AIR 3.5 to run the application. You can download ADOBE AIR 3.5 or newer version from http://get.adobe.com/air/.

In addition, you need to check that your computer has the following minimum requirements to run iSub:

Windows

- 2.33GHz or faster x86-compatible processor or Intel® Atom™ 1.6GHz or faster processor for netbooks
- Microsoft® Windows® XP Home, Professional, or Tablet PC Edition with Service Pack 3; Windows Server® 2003; Windows Server® 2008; Windows Vista® Home Premium, Business, Ultimate, or Enterprise (including 64-bit editions) with Service Pack 2; or Windows 7
- 512MB of RAM (1GB recommended)

Mac OS

- Intel® Core™ Duo 1.83GHz or faster processor
- Mac OS X v10.6, v10.7, or v10.8
- 512MB of RAM (1GB recommended)
2.2 INSTALLING ISUB

To install iSub, follow these steps:

1. Before you can install iSub, you will need to download ADOBE AIR 3.5 or newer version and install it. If you have already done this, you can skip this step.

2. Download iSub installer from https://engineering.purdue.edu/people/hyung.j.ahn.1. The iSub installer icon should appear on your desktop.

3. Run iSub Installer by double-clicking on the iSub_Install icon on your desktop. An application install status window should appear followed by an application install window. Click the Continue button to continue.
4. You will be asked whether ADOBE AIR to be installed or not if you have not already installed ADOBE AIR in your computer. Click the I Agree button to continue.

5. You will then have to specify the installation location and click the Continue button.
6. You have finished installing iSub and an icon shown below should now appear on your Windows desktop.
3 OVERVIEW

iSub consists of five tabs, namely General, Analysis Input, Result and Attachments.

3.1 APPLICATION MENU

Application menus are located in the upper left corner of the window and consist of File, View and Help.

3.1.1 FILE

The figure below illustrates the File menu.

- **New**: Opens a new sheet. (Keyboard shortcut CRTL + N).
- **Open**: Opens the selected file (Keyboard shortcut CRTL + O).
- **Save**: Saves the current work or any changes to a folder on your hard disk. The name of the file is automatically generated as Date_Time.indot and the default file save location is set to your computer’s desktop. (Keyboard shortcut CRTL + S).
- **Save As**: Saves the current work or any changes to a folder on your hard disk. Although the name of the file is automatically generated as Date_Time.indot, the save as dialog appears. (Keyboard shortcut CRTL + A).
- **Exit**: Closes the entire program. If there are multiple sheets, it closes them all at the same time (Keyboard shortcut CRTL + Q).
3.1.2 VIEW

The figure below illustrates the View menu. This allows a user to switch between different tabs and displays the keyboard shortcuts designated for each tab.

![View Menu Example]

3.1.3 HELP

The figure below illustrates the Help menu. This provides the manual and software version information.

![Help Menu Example]
3.2 TAB

3.2.1 GENERAL

The **General** tab is the default screen when the software is launched. This allows a user to input general information regarding the test site location along with analysis level to be applied.
### 3.2.2 ANALYSIS INPUT

The **Analysis Input** tab presents a user to input values required to calculate the subsurface condition, including Layer Depth, Layer Thickness, R. P., Tensile Strength, Water Stripping Severity, Bulk Specific Gravity (Gmb), Maximum Specific Gravity (Gmm), and Air Voids. The procedures for each test available from “GUIDELINES OF SUBSURFACE CONDITION EVALUATION FOR PAVEMENT PRESERVATION TREATMENTS.”
### 3.2.3 RESULT

The **RESULT** tab presents analysis results as a summary and instantly updates as any changes occur in selected values. Overall condition is automatically calculated and displayed once the required data are defined in the software and update once any change in the value in the **Analysis Input** tab detected. The **RESULT** tab also features a **Print Report** option button in the left lower corner of the window, which allows a user to print detailed report. A detailed report shows every value input by a user and analysis result in PDF format. The figures below illustrate **RESULT** tab.

![RESULT tab example](image)

The table below shows the analysis results for different layers.

<table>
<thead>
<tr>
<th>Layer</th>
<th>Air Voids</th>
<th>Tensile Strength</th>
<th>Water Stripping</th>
</tr>
</thead>
<tbody>
<tr>
<td>Layer 1</td>
<td>N/A</td>
<td>N/A</td>
<td>N/A</td>
</tr>
<tr>
<td>Layer 2</td>
<td>N/A</td>
<td>N/A</td>
<td>N/A</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Layer</th>
<th>Overall Condition</th>
<th>Coverage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Layer 1</td>
<td>N/A</td>
<td>0</td>
</tr>
<tr>
<td>Layer 2</td>
<td>N/A</td>
<td>0</td>
</tr>
<tr>
<td>Total</td>
<td>N/A</td>
<td>0</td>
</tr>
</tbody>
</table>
3.2.4 ATTACHMENTS

The **Attachments** tab displays a list of attached files. This feature essentially works the same way as attaching a file to an email. Furthermore, it provides a drag and drop function, which allows a user to simply drag any file to a software window and automatically the file in that location. This feature also provides options to manage multiple files at once by selecting the check box located in the lower left corner of the window.
4 GETTING STARTED

4.1 LAUNCHING iSub

Run iSub by double-clicking on the iSub icon on your desktop or in your Windows Start menu.
4.2 DESIGN EXAMPLE

The following example illustrates how to evaluate subsurface condition using iSub step by step. Procedures presented in this example are designed to help the first-time user to become more familiar with iSub, but hereafter a user may enter and edit values for each required input in any order.

4.2.1 STEP 1

Enter evaluation date along with engineer name.
4.2.2 STEP 2

Enter location information. For district selection, the user can choose from one of six districts of Indiana. Once a district is selected, a list of subdistricts corresponding to the selected district becomes available. Beginning and end point of test section can be represented either road name or R. P. In case of 2-way road, driving lane can be selected for lane location.
4.2.3  **STEP 3**

Enter analysis information and additional comments in the blank space provided. There are three analysis levels, such as Level 1, Level 2, and Level 3. For the selection of proper analysis level, refer to Guideline. Total coverage is the combined coverage of all layers considering the overlapped locations. The overlapped locations are a certain sections which were determined to be problematic in more than one layer or covered with more than one type surface distress. Consequently, overlapped locations should only be counted once in the calculation of total coverage.
4.2.4 STEP 4

The tables in **Analysis Input** tab are generated based on the information given in analysis level in **General** tab. Enter laboratory test results for each replicate and layer. A user can input air voids by directly typing values in the box or iSub automatically calculated once Gmb and Gmm values are given.
### 4.2.5 STEP 5

Review the results. iSub determines condition of each layer based on the analysis input and overall condition along with coverage once the necessary input values are presented.

<table>
<thead>
<tr>
<th>Layer</th>
<th>Air Void</th>
<th>Tensile Strength</th>
<th>Water Stripping</th>
</tr>
</thead>
<tbody>
<tr>
<td>Layer 1</td>
<td>Poor (15)</td>
<td>Good (120)</td>
<td>Poor (20)</td>
</tr>
<tr>
<td>Layer 2</td>
<td>N/A</td>
<td>N/A</td>
<td>N/A</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Layer</th>
<th>Overall Condition</th>
<th>Coverage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Layer 1</td>
<td>Poor (33)</td>
<td>0</td>
</tr>
<tr>
<td>Layer 2</td>
<td>N/A</td>
<td>0</td>
</tr>
<tr>
<td>Total</td>
<td>Poor (33)</td>
<td>0</td>
</tr>
</tbody>
</table>
4.2.6 STEP 6

If you would like to print a detailed report that contains general information as well as analysis input, click the **Print Report** button located at the bottom of the window. iSub will generate a report in PDF format.
4.2.7  STEP 7

The user can attach any type of file with no size limit. The figure below illustrates how to add or delete attached files.

To add files, follow these steps:

1. Click the **Attach a File** button.
2. Select a file and then click **Open**.
To delete files, select files by clicking the box, then click the **Delete** button.
4.2.8 STEP 8

The last step is to save your work. You can save your work at any time by typing the keyboard shortcut CTRL + S.

To save your work, follow these steps:

1. Click the **File** button.

2. Click either the **Save** or the **Save As**.